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Revision history 
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naming, added bass control and master volume. 
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SUPPORT: 

If you have any queries regarding the use of the ImmerGo system, contact Richard Foss at: 

richardfoss@minidsp.com 
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1 WELCOME TO IMMERGO! 
 
This manual will describe how to configure and use the ImmerGo24 system. Before engaging with this topic, it is 
useful to have a broad understanding of the operation of the ImmerGo system. We shall look first at the 
components of an ImmerGo24 system, and then provide a conceptual understanding of how they interact with 
each other. With these concepts in place your task of configuration and immersive sound creation will be a lot 
easier. 

1.1 IMMERGO24 SYSTEM COMPONENTS: 
 
Given below is a diagram of the hardware components of an ImmerGo24 system: 
 

 
 
Note: the connection from the server to the switch should be a Thunderbolt to Ethernet connector. If you have a 
machine that only has USB-C plugs, then you will need two connectors – USB-C to Thunderbolt, Thunderbolt to 
Ethernet. 
 
As a user, you will be controlling the localization of sound sources from a mobile device such as a tablet or smart 
phone. Multiple users can control the localization of multiple sound sources at the same time. The sound 
sources are typically wav files associated with audio tracks in a Digital Audio Workstation (DAW). The DAW will 
be installed on the server machine, typically a Mac Mini or MacBook. Also on the server will be the 
ImmerGoServer software, which you will need to install. 
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1.1.1 How do the components interact? 
 
An ImmerGo user with a mobile device can do two things: 

1. Control the localization of sound sources 
2. Control the transport of the DAW 

 
When a user controls localization of sound sources, the 3D sound source positions get sent over a wireless 
network to the server. Using these 3D sound source positions, and the positions of the speakers, the server 
determines what control values to send over the Ethernet AVB network to the SPK-4P speakers. 
 

 
 
When a user controls the transport of the server-based DAW, transport control commands are sent over a 
wireless network to the server. The server then sends MIDI commands to the DAW to control its transport. MIDI 
timecode messages are sent from the DAW to the server for the time stamping of localization changes. They are 
also sent to the client for display. 
 

 
 



    
 

immersiveDSP Ltd, Hong Kong / www.immersivedsp.com / Features and specifications subject to change without prior notice 6 

2 PRE-PREPARATION BEFORE INSTALLING SERVER  

 

Your OSX server will be communicating with an Ethernet AVB network, which is a wired network. It will also be 
communicating with one or more mobile devices over a wireless network. You should ensure that there is just 
one wired Ethernet connection, and that is connected to the Ethernet AVB switch of your Ethernet AVB 
network.  

Go to the network system preferences on your computer, select the Ethernet network, and set the field 
‘Configure IPv4:’ to ‘DHCP’. 

See the example below. 
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3 DIGITAL AUDIO WORKSTATION (DAW) CONFIGURATION 

3.1 DAW COMMUNICATION WITH SPK-4PS 
 
Your first DAW configuration task is to enable the DAW to communicate with the SPK-4P Ethernet AVB speakers. 
You should be running an Apple Mac computer (Mac Mini or MacBook) with an OSX version 10.12 or higher. 

In order to utilize the AVB features, you need to make use of Apple’s avbutil tool. The avbutil tool allows you to 
enable an AVB virtual device on the Mac workstation (virtual entity), and also to have a controller. The controller 
allows you to get information about all the AVB devices on your network, and also to connect them together via 
a connection matrix. 

First run the Terminal Mac application to get a terminal window going on your Mac. You should then use the 
following commands from the terminal prompt: 

1. ‘networksetup –listallhardwareports’ to determine the name of your Ethernet device (interface-name). 
This will be a name such as en0, en1, en3, …, and is known as the ‘interface name’. 

2. ‘avbutil –-virtual-audio enable <interface-name>’ – to enable the virtual audio entity on your Ethernet 
interface. This virtual entity is the source of audio streams from your Mac. 

3. ‘avbutil –-controller to enable and launch the AVDECC controller. AVDECC stands for ‘Audio Video 
Discovery, Enumeration, Command and Control’. It is the AVB control protocol. 

Here is an example of commands 2 and 3 in the above list: 

 

 

After running the controller, the entity controller should run and you should see the typical application icon in 
the Dock bar.  

 

 

 

 

Right click on the icon and set it to stay in the Dock.  
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At any time, to launch the entity controller: 

1.  Click on the application icon to select the avbutil application, 
2. Select ‘Window’ from the menu bar, and then ‘Entity Controller’.  

An Entity Controller window will appear that will list all the AVB devices as well as the virtual entity on your Mac 
workstation. The virtual entity name will incorporate the name of your workstation. 

You should see a window similar to the one below. 

 

 

In this window, you will see your SPK-4P speakers (AVB PoE+ Speaker), as well as the virtual audio entity, which 
will be identified by the name of your Mac. Select the virtual audio entity and ensure that you choose an 
appropriate channel configuration option in the ‘Current Configuration’ field. This option should be:  

128 in, 128 out, 24 + 8 ch streams  

This indicates the number of audio channels within each audio stream that is transmitted by the virtual audio 
entity. 

The AVDECC controller allows you to view and manipulate a connection matrix. Choose the AVDECC Connection 
Matrix option from the Window menu.  
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The connection matrix shows all the possible input and output stream connectors on the AVB devices in your 
system. In the connection matrix shown below an output stream from the virtual audio entity is connected 
(shown by a cross) to the input stream connector of each of two SPK-4Ps. You will not need to make these 
connections as ImmerGo will make the connections for you. The connection matrix will provide confirmation 
that connections have been made.  

 

 

Note that currently in ImmerGo24, we just make use of the first output stream of the virtual entity. This allows a 
DAW to make use of 24 audio output channels. When using a DAW, you can associate each of the tracks with 
one of the 24 channels. In the Reaper DAW, this would be done by utilizing the connection matrix, as shown 
below: 
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3.2 MIDI COMMUNICATION BETWEEN IMMERGO SERVER AND DAW 
 
The ImmerGo server communicates with the DAW in order to control its transport. It also receives MIDI Time 
Code from the DAW, which it uses to time stamp 3D coordinates it receives from the mobile client(s), and which 
it also forwards to the mobile client(s) for display purposes. To enable this, the DAW must be set up to receive 
messages on the same MIDI link as used by the server (internal driver), to respond to particular MIDI transport 
control messages, and to transmit appropriate MIDI Time Code messages. 

3.2.1 MIDI internal driver 
 
The DAW should be set up such that it reads MIDI from IAC BUS driver 1 and transmits MIDI on IAC BUS driver 1. 

3.2.2 MIDI and transport control 
 
The DAW on the server needs to be configured in such a way that it will receive MIDI transport commands and 
respond appropriately. Here are the MIDI messages and the transport controls that they are associated with: 
 
 

Transport control MIDI Message (hexadecimal) 
Play B0   1A   00 
Stop B0   1C   00 
Pause B0   1B   00 
Fast Forward B0   1F   00 
Rewind B0   1E   00 
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3.2.3 MIDI Time Code 
 
The DAW needs to be configured such that it generates MIDI Time Code. By default the frame rate for the 
timecode is 30 frames/second. 

3.3 MIDI CONFIGURATION WHEN USING THE REAPER DAW: 
 

1. Set up MIDI correctly. Select Setup -> MIDI -> MIDI Studio. You should then see the following screen: 
 

 
 

Double click the ‘IAC Driver’ icon. In the IAC Driver Properties window, select “Device is online” to turn on the 
driver. 
 
You will have received a zip file called ReaperFiles. When you unzip this, you will find : 
 

1. ImmerGoTemplate.zip – this contains a multitrack Reaper project with a MIDI Time Code generator in 
the first track and also the MIDI transport control appropriately configured. 

2. Immergo.ReaperConfigZip – this is a configuration file that should be imported into your Reaper project 
if you do not use the template file. This importing can be done in the following way: 

 
Go to: Options -> Preferences -> General.  Then select Import configuration, as shown below: 
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This will set up MIDI transport control appropriately, and will also configure the MIDI drivers. However, you will 
need to create a MIDI Time Code track for the transmission of MIDI Time Code. Refer to the Reaper user guide 
for this. If you use the SkalandunasI project, then this is already created for you, and you could use this project 
as a template for others. 
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4 INSTALLATION OF THE SERVER 

 
You should have received an installation zip file ImmergoSPK4.zip. Place this file into a folder on your server, for 
example the Documents folder and unzip it with the archive utility (right click on it): 
 
 

 
 
 
In the folder ImmergoSPK4 you should see the following files: 
 

 
 

• fastclick, ImmergoClient, main, Raphael, and raphaeltools - are all files that will be used on your client 
device. 
 

• SpeakerConfig - contains your speaker layout. 
 

• ImmergoServer is the server application that you need to run on your server computer. 
 
Open  ImmergoServer (right click, select Open). When you first open the server on your machine, it may take a 
few seconds before the server window appears. 
 
You should see the following window (with differences appropriate for your working folder location and for your 
network addresses): 
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4.1 WORKING FOLDER: 
 
The ‘Working Folder’ should be the folder from which you launched the server and should not need to be 
changed. If you would like to keep your mobile device and speaker configuration files in a folder different from 
the server application folder, then this is where you would browse to that folder. 

4.2 NETWORKS: 
 
ImmerGo requires the use of two networks – the Ethernet AVB network which your server and NDAC devices are 
connected to, and a wireless network to which your server and mobile device(s) are connected. There should be 
an IP address listed for the server’s IP address on each of these networks. If either of these IP address 
placeholders indicates ‘undefined’, then exit the server application and ensure that your server is connected to 
both networks. A URL is provided for you to type into your mobile device(s) browser when you start controlling 
the localization of sound sources. 
 
MIDI Port selection: 
The IAC BUS internal software MIDI link is used to allow the server to communicate with the DAW. Both the 
input and output ports should be set to IAC Driver Bus 1. 

4.3 NUMBER OF SPK-4PS DISCOVERED: 
 
This section indicates how many SPK-4Ps have been discovered by the ImmerGo server 

4.4 MIDI PORT SELECTION 
The IAC BUS internal software MIDI link is used to allow the server to communicate with the DAW. Both the 
input and output ports should be set to IAC Driver Bus 1. 

4.5 CONNECTION MANAGEMENT 

 Your last interaction with the server is to connect the server to each of your SPK-4Ps. This is done by simply 
clicking the Connect button.  

Note: Before proceeding with this step, you should be familiar with the speaker configuration process described 
in section 5 below. 

The connection process takes a few seconds, and the number of devices connected should be displayed in the 
box below the Connect button. Make sure that all your SPK-4Ps are connected before you start using the 
immerGo client. 
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5 SPEAKER CONFIGURATION 

 
immerGo needs to know the positions of the speakers in your room in order to correctly localize the audio tracks 
that you select and move. When localizing sounds, immerGo refers to a file named speakerconfig.xml that 
resides in your working folder. This section describes a graphical configuration capability within immerGo that 
allows you to place the speakers within a graphic representation of your room. After positioning your speakers, 
you can save the configuration and this will cause immerGo to create the speakerconfig.xml file in your working 
folder. As in the case of localization of sound sources, you can perform graphical speaker configuration within a 
client that resides on the server or on a remote mobile device. 

5.1 STARTING THE CONFIGURATION 

When you start the immerGo server for the first time, you will have one of the following two situations: 

1. There will be no speakerconfig.xml in the working folder 

2. There will be a speakerconfig.xml in the working folder, but it will not be aligned with your SPK-4s. 

In either case, the server will indicate that you need to start a client to configure your speakers. 

Similarly, when you start up a client, you will be told that there is no speaker configuration file, and asked to 
continue with the configuration process. On continuing with the configuration process, you will be presented 
with a representation of a room, and a series of configuration control buttons, as shown below. 
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5.2 CONSTRUCTING A CONFIGURATION 
 
Before you start adding speakers to your configuration, you should first: 
 

• Measure the dimensions of your room: 
o Length – the distance from the center of the front-most speaker, to the center of the speaker 

that is furthest back in the room.  
o Width - the distance from the center of the left-most speaker, to the center of the speaker that 

is furthest to the right of the room.  
o Height – the distance from the center of the bottom-most speaker, to the center of the speaker 

that is highest in the room.  
• Enter the dimensions of the room (cms) – type in the length (l), the width (w) and height (h), then click 

‘submit’ or type <enter> after your last entry. 
 
The top row of buttons corresponds to all the possible speakers in your configuration. For example, if you have a 
single N-DAC8, then there will be 8 speaker buttons. If you have two N-DAC8s, then there will be 16 speaker 
buttons. immerGo uses sound (a short ‘Beep’) to help you associate a speaker button with a particular speaker 
in your actual configuration. To enable this capability, you need to make sure that the default sound output for 
your Mac is the ThunderBolt Ethernet interface. To do this: 
 

1. Select your Apple ‘System Preferences’ 
2. Select Sound 
3. Select ‘Output’ 
4. Choose the ‘your Mac name’:Thunderbolt Ethernet interface. 

 
An example is shown below: 
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To add a speaker to your configuration, you should do the following: 
 

1. Select a speaker button – it will highlight as the selected speaker. 
2. Select the ‘Beep’ button – if you hear a speaker beep, you know that the speaker is indeed part of your 

configuration, and you can locate it. 
3. Select the ‘Add’ button – this will cause the speaker to appear in the middle of the room, as shown 

below. 
 

 
 

4. Drag the speaker to a position that represents its actual position in the room. You can use the slider to 
adjust the speaker height (the white rectangle indicates the height of the speaker). If you are using a 
mobile device, you can select the up/down check box and adjust the height of the speaker by tilting the 
mobile device.  

5. As you re-position the speaker, the x, y and z coordinate values (in cms) will change. The coordinates are 
relative to the bottom left front of the room.  

6. If you select a speaker, select ‘Beep”, and there is no sound, it could be that there is not an actual 
speaker associated with that speaker button. In this case, you could select the ‘disable’ button. This will 
give the selected speaker button a purple outline, and it will afterwards no be selectable. Selecting the 
‘Enable’ button’ will re-enable all disabled speaker buttons. 

7. If none of the speaker buttons respond to a ‘Beep’ request upon selection, then there is probably a 
problem with your AVB network configuration. Go back to section 3.1, and check that you have fulfilled 
the requirements. In particular check that there are connections in the AVB connection matrix.  
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8. Bass speakers – you can add one or more bass speakers to your configuration by doing the following: 
a. Select a speaker 
b. Select the ‘Bass’ button – the ‘Spkr’ text on the button will be replaced by ‘Bass’. 
c. Beep the speaker to determine its location 
d. Move the bass speaker to its allocated location in the room 

Note that if a speaker is designated as a bass speaker, immerGo will direct all non-muted tracks to that 
speaker. 

 
Following this configuration process, you may have a room configuration that appears as shown below: 
 

 
 
To save this configuration, select the ‘Save’ button. This will save your configuration in the speakerconfig.xml file 
in your working folder. You can now immediately start localization control by selecting the ‘Controls, button. In 
the case of the above configuration, the immerGo client interface would appear as follows: 
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As you can see, the speaker positions in the localization page correspond to the positions that you set up in the 
configuration page. Note that while displaying the speakers in the localization page, immerGo re-computes the 
room length and room width, such that the room border fits more exactly around the speakers.  
 
You can view the contents of the speakerconfig.xml, and indeed you can edit the coordinates that are within the 
file or even create a whole new set of coordinates. Remember that the units are centimeters, and the 3D 
coordinates are measured relative to the bottom front left of the room. 
 
Given below is a listing for the speakerconfig.xml that corresponds to the above configuration. 
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The ‘amplifier’ entity refers to an SPK-4P, which has a unique Ethernet address. Each ‘speaker’ entity, associated 
with the SPK-4P, has a speaker number, x, y, and z centimeter coordinate values, a type which could be ‘normal’ 
or ‘bass’, and an indication of whether the speaker is used or not. The ‘used’ attribute is used to take account of 
a situation where not all of the secondary speakers on the SPK-4Ps are actually connected. 
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6 THE MOBILE CLIENT 

 
You are now ready to run the ImmerGo client on your mobile device. The server page provides you with a URL 
that you can type into your mobile device browser. This will be something like the following: 
 
http://146.231.181.139:8001/ImmergoClient.hml 
 
but will vary depending on the IP address of your server. Once you have entered and activated this URL in your 
browser, you should be presented with the following graphical user interface: 
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6.1 A GUIDE TO THE IMMERGO CLIENT USER INTERFACE 
 
This interface will vary, depending on the configuration of speakers in your SpeakerConfig.xml file. 
 
The top half of the user interface is a representation of the room that contains your speakers. The view is from 
the top of the room.  The bottom half of the user interface comprises a number of buttons, sliders and 
checkboxes that all enable control over the recording and play back of multitrack immersive sound. 
 
This short guide will describe each of the labelled items in the representation of the user interface shown above. 
 

1. The representation of the virtual source that a user can move in the horizontal plane. The sound that 
will be localized derives from the currently selected track. 
 

2. A check box that, when ticked, enables the vertical control over the virtual source. As you tilt the mobile 
device upwards and downwards, so the virtual source position will rise and fall.  

 
3. This white rectangle indicates the vertical position of the virtual source. If the Up/Down check box is 

ticked, then the rectangle will move as the mobile device is tilted up and down. 
 

4. This slider responds to mobile device orientation, in particular up/down tilts. If ImmerGo is run on a 
desk top or laptop, then this right vertical slider can also be used to control the vertical position of the 
virtual sound source, and thus the position of the white rectangle.  

 
5. A representation for a speaker that is installed in the ceiling (top of the room). 

 
6. The Track selection buttons. They allow you to select a particular source within a DAW that will be 

moved within a 3D space. The tracks correspond to outputs from a DAW, and also to Ethernet AVB 
stream channels. With the SPK-4 ImmerGo system, there are a maximum of 24 stream channels, and 
thus a maximum of 24 tracks that can be localized. A DAW will typically allow you to mix multiple DAW 
tracks onto a single channel. The ‘<<<’ and ‘>>>’ buttons allow you to display further tracks, either 
higher or lower numbered. 

 
7. DAW transport control buttons. These buttons allow you to control the transport of the server side DAW 

from your mobile device. There is also a timecode display that will change while your DAW soundtrack 
plays. 

 
8. Miscellaneous buttons: 

 
a. Mute/Solo – allow you to mute or solo the selected track. The Track buttons will be highlighted 

appropriately to indicate muting. To un-mute a muted track, select the track and tap the Mute 
button. Similarly, to un-solo a solo’ed track, select the track and tap the Solo button. 

b. Record – in order to record your localization moves, you should: 
 

i. Select a track 
ii. Tap the Record button 

iii. Tap the Play button 
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iv. Move the virtual source circle and/or the white rectangle 
v. Tap Stop when complete 

c. Display – if you select a track and tap this button, then a small track circle will indicate the 
location of the virtual source for that track when your stored localizations are played back. You 
can display more than one virtual source. 

d. Save/Load – will allow you to save your time stamped localizations and load them back at a later 
time. Note, you can record over any track’s localizations at any point within the time line of your 
saved localizations. Simply choose a track, record, then stop when complete. 
 

9. Spread – this slider controls how ‘wide’ the sound source seems. 
 

10. Track Volume – allows for the control of the volume of the selected track. 
 

11. Bass – This button is relevant if you have one or more sub-woofers in your speaker configuration. Then if 
this button is selected, the track volume control slider will control the volume of the sub-woofers. 
 

12. Master Volume – As its name implies, this slider will control the volume of all tracks and thus raise or 
lower the volume of the entire multitrack being played back by the DAW. 
 

13. Settings – This button is used to take you to a ‘Settings’ screen where you can modify various immerGo 
settings. Currently the only available is a ‘Names’ settings, allowing you to modify the names of the 
tracks. This capability will be described in the following section. 

 

6.2 SETTING THE NAMES OF TRACKS 

When you first load the immerGo client, the track buttons are labelled Track1, Track2, etc. The track naming 
capability allows you to provide meaningful names for each of the tracks. This makes it easier to choose a 
particular track for localization.  

In order to access this capability, you need to select the ‘Settings’ button. This will take you to a new display, 
where you can: 

1. Select a track to re-name 

2. Select the ‘Name’ button 

3. Type in the new name of the track 

 

This is shown in the screenshot below: 
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You can return to the localization control screen by clicking the ‘Controls’ button. 

 

6.3 CREATING A NEW MULTITRACK LOCALIZATION FILE 
 
If you have started the ImmerGo server, and have not loaded a localization file, then you can start recording new 
position changes for up to 8 tracks. First, you must start a DAW such as Reaper, and ensure that the DAW is 
properly configured. Refer to the DAW configuration section above. Now to record source position changes for a 
single track you should: 
 
1. Select a track by tapping a track button (Track1 …Track24) 
 
2. Tap the ‘Play’ button and listen to the track’s movement as you move the virtual track circle and tilt/swivel 

your mobile device. This should give you a sense of the nature of the source position changes that you 
would like to make during the playback of the multitrack soundtrack. You should see the timecode display 
change as the soundtrack plays. If you would like to hear only the track whose positions you are recording, 
then ‘Solo’ the track by tapping the ‘Solo’ button. 
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Note: A typical approach to ImmerGo localization control is to position the sound source horizontally by 
moving the sound source circle, and at the same time position it vertically by tilting the mobile device up 
and down (after checking the up/down check box). In this way the position of the sound source circle as well 
as the position of the height rectangle give you a good visual sense of the sound source position.  

 
3. Now tap the ‘Record’ button and then the ‘Play’ button. As you move the virtual sound source circle and/or 

change the orientation, the server will record the 3D position of the chosen track’s sound, as well as the 
current time. 

 

 
 
 
4. Tap the ‘Stop’ button when you have finished localizing the track. 
 
5. You can now localize a different track. To do this, first select the new track and if you want to only hear this 

track while you localize, then tap the Solo button. If you want to hear the previously recorded track as well 
as the new one, then select the previously recorded track and tap the Mute button to unmute the track. 

 
6. While localizing a new track, you can visualize the movements of other tracks, by using the ImmerGo 

‘Display’ feature. Select the track you want to visualize, and tap the Display button. Given below is the 
ImmerGo user interface with multiple tracks displayed. 

 



    
 

immersiveDSP Ltd, Hong Kong / www.immersivedsp.com / Features and specifications subject to change without prior notice 27 

 
 

 
7. At any point, you can save your localization recording to disk. Tap the ‘Save’ button and type in the name of 

your file in the dialog box that pops up. Your file will be saved, with the ‘.imm’ extension, in your working 
folder. 

 
Note: It is possible to record over any localization for any track at any point in the multitrack recording. You 
could for example: 
 

a. Pause playback at a point where you would like to change the localization for a track. Then you can 
select the track, tap record, tap play and proceed to change the localization. 

b. While you are playing a multitrack with its localizations, you could select a track, tap record and proceed 
to change the localization. 

 
For both the above cases, tap Stop to end the localization change. 
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Note:  If at any point you are not able to control the transport of your DAW from your client device, make sure 
that the AVB interface is selected in your DAW. It may be necessary to re-select even if the interface was 
previously selected. In Reaper this is done by selecting  Options -> Preferences -> Device. 

 


